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shell). In some cases, the document may take several seconds to open. In others, the
document may not open at all and Explorer will appear to hang. In this case, closing the
Modbus OPC Server should bring Explorer back to life.

• If any part of iTools should terminate with an error, it is possible that the Modbus OPC
Server and other elements of iTools may still be in memory. This may prevent iTools
running successfully until the problem is resolved. If you suspect that this may have
happened, you should use a Task Manager or Process Viewer application to ensure that
neither EUROMBUS.EXE nor any application named ID*.EXE is still running.

• When iTools is uninstalled, some files may be left behind. These should be removed
manually.
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2. CHAPTER 2   Installation

2.1. CABLING

The 2-wire, RS485 standard will normally be used for communicating with series 2000
instruments.  This standard allows the following:
1. Connection of multiple instruments
2. The distance from instrument to PC up to 4000 feet up to baud rates of 100Kbaud.
3. The environment is electrically noisy

If required, a single 2400 series instrument can be connected directly to the PC, usually to
COM1 or COM2, using the RS232 standard.  Ensure that the 2400 has the correct
communications modules fitted.

A full description of the standards and wiring details is given in the relevant Eurotherm
instrument handbooks.  See Appendix C for related handbooks and their part numbers.
An overview is reproduced as follows:

2.2. GROUNDING

To reduce interference from external electrical signals, ground the cable screen at a single
ground point.  There should not be multiple ground paths in a single cable run.  When using a
Eurotherm Controls KD485 Communications Adapter unit, do not connect the screen from
one side of the interface to the other.  Rather, ground each of the cables separately at a local
ground point.

2.3. WIRING GENERAL

Route communications cables in separate trunking to power cables.  Power cables are those
connecting power to instruments, relay or triac ac supplies and wiring associated with
external switching devices such as contactors, relays or motor speed drives.

Communication cables may be routed with control signal cables if these signal cables are not
exposed to an interference source.  Control signals are the analogue or logic inputs and
analogue or logic outputs of any control instrument.  Multiple instruments must be ‘daisy
chained’, as shown in figure 2-2, avoiding parallel connections.

Do not use redundant wires in the communications cable for other signals, and do not use the
screen as a substitute for the common connection.

Ensure cable runs have sufficient slack to ensure that movement does not cause abrasion of
the insulating sheath.  Do not over tighten cable clamps to avoid accidental multiple
grounding of the screen conductors.

Refer to ‘EMC Electromagnetic Compatibility’ guide Eurotherm part no. HA025464 for
further information.
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2.4. DISCRETE INSTRUMENTS

2.4.1. Wiring RS232

Figure 2-1:   Connecting a Single Instrument

2.4.2. Wiring RS485

Figure 2-2:   Connecting up to 32 Instruments

For 2200 & 2400 series controllers recommended
cable:

CABLE/9PINPC/NOPLUG/232/3.0M

PC

Com RxTx Tx Com Rx

2200  &
2400 series
instrument

PC

Com RxTx

220 ohm
termination
resistor
on the Rx of the
converter unit

TxRxCom

Tx
Tx- Rx+

Rx-
Com

Type
KD485
converter

RS485

Controller 2

Com

Controller 1

HF (B+ Tx)

HE (A+ Rx)
Com

HE (A+ Rx)

HF (B+ Tx)

220 ohm
termination
resistor
on the last
controller in the
chain

Twisted pairs
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2.5. TO INSTALL ITOOLS SOFTWARE

Note:

The iTools package consists of a set of 3.5 inch disks.

• Insert the disc labelled disc 1 into the diskette drive of the PC, - this will usually be drive
a.

• From the Windows Start Bar, click Run
• Type a:\SETUP

The set up program prompts you through the installation process.
Follow the instructions on the screen.

The drive on which iTools will normally be installed is drive C: but an alternative drive may
be chosen.

The directory where iTools will normally be installed is \Program Files\Eurotherm\iTools.
Other locations are allowed and may be chosen using usual Windows methods.

Note:  Any version of iTools already installed in this directory will be overwritten unless a
different directory is specified.

2.6. COMMS PORTS

iTools will support up to eight comms ports.  During installation you will have been asked to
specify which comms ports your instruments will be connected to.  ITools automatically
scans for instruments connected to these ports (see paragraph 3.4  ‘Autodetection’ )

If you are installing iTools and already have a version of iTools on your system, it is
best to ‘uninstall’ the older version rather than just writing over it.  To do so select
Settings from the Windows Start Bar.  Click Control Panel and double click on
Add/Remove Programs.  Select iTools and click Add/Remove.  Confirm the
deletion by clicking Yes when prompted.  Then click OK  through two consecutive
dialog boxes.  The existing version of iTools is uninstalled, and you are ready to
install this version.
Installation of a new version of iTools should not affect clone files which have already
been produced.  Clone file simulations, however,  which are supplied as part of the
upgrade will be overwritten.  It is, therefore, advisable to make a backup of all clone
files prior to installation of a new version of iTools.
It is also recommended that all other Windows programs are closed down during
installation.
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2.7. STARTING AND EXITING ITOOLS

2.7.1. To start iTools
iTools may be started in either of the following ways:
 
I. Directly

A. From the Windows Start Bar, click Programs.
B. Select Eurotherm iTools
C. Click iTools

 
II. Indirectly

A. Open an instrument clone file, recognisable by its .uic file extension,
directly from Windows Explorer.

2.7.2. To exit iTools

1. Click Exit  from the iTools File menu,

2.8. TO ACCESS HELP

1. From the Help menu, select Contents.  The help Contents tab appears;  select a topic or
use the Index or Find tabs
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3.  CHAPTER 3   Quick Tour 1

3.1. THE BASICS

This quick tour is a step by step tutorial in which you run iTools, scan for all connected
instruments and operate connected instruments from the screen.

Note:  This chapter shows 2200 and 2400 series instruments only, but the principles apply
equally for other 2000 series instruments such as 2500DIN Rail Controller.

Note:  This quick tour assumes that you have a basic understanding of Windows 95, or NT
system.

About this Quick Tour

◊ Starting iTools

◊ To open views of instruments

◊ Auto-detection

◊ Baud rate

◊ To operate an instrument

◊ Instrument parameters

◊ To change parameter values

◊ To edit parameters

◊ To customise the display

◊ To display parameters of two or more instruments

◊ Storing parameters in recipe
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3.2. STARTING AND EXITING ITOOLS

3.2.1. To start iTools
iTools may be started in either of the following ways:
I. Directly

A. From the Windows Start Bar, click Programs.
B. Select Eurotherm iTools
C. Click iTools

II. Indirectly
A. Open an instrument clone file, recognisable by its .uic file extension,

directly from Windows Explorer.

3.2.2. To exit iTools
1. Click Exit  from the iTools File menu,

On a new application, the iTools window appears as follows:

Figure 3-1:   The iTools Start Up Window

3.3. TO OPEN A REPLICA (OR VIEW) OF INSTRUMENTS

Replica views of instruments may be opened in either of the following ways:

1. By enabling background scanning for new devices.  This can be from the iTools main
menu or toolbar

2. By selecting the Add Devices command from the iTools menu or toolbar.  This will
display a list of available devices (both real and simulated) to select from

These methods are described further in the following pages.

Menu Bar

Toolbar

Status Bar



Quick Tour 1 iTools

3-4 User Handbook.         Part No HA026179       Issue 2.0            Oct-99

3.4. AUTODETECTION

1. Press the button.                                This will change to Scanning

During the auto-detection process, iTools will search for up to 32 connected Eurotherm
instruments.  It will automatically check all instrument addresses and baud rates.  (see also
paragraph 3.4.1 ‘Baud Rates’).

When instruments have been found, instrument views are automatically displayed in the
iTools window (assuming Panel Views has been checked in the View menu).  The displayed
values are coloured yellow to indicate that these are physically connected instruments.  Once
all instruments have been detected, stop iTools scanning by pressing the Scanning button
which will change to Not Scanning.

If no instruments are detected then no unit face-plates will be presented.

Figure 3-2:   Instrument Views

3.4.1. Baud Rates
During the autodetection process, iTools will automatically scan for instruments connected to
the comms ports.  It will assume the baud rate of the first instrument detected - i.e. the one
with the lowest address.  Any subsequent instrument which has been set to a different baud
rate will show in iTools as a ‘Comms Error’.  Baud rates of 1200, 2400, 4800, 9600 and
19,200 can be set in the 2200 and 2400 series instruments - the factory default being 9600.
Baud rate is set in the Configuration Mode of the instrument - see the relevant user handbook
listed in Appendix C.

RUN
HOLD

AUTO
MAN

Click here and drag to change
the size of the instrument view
area
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3.4.2. To Operate An Instrument

Instruments can be operated directly from the instrument views on the PC screen in exactly
the same way as the instrument itself.  A full description of the operation of an instrument is
given in the relevant Installation and Operation Manual for that instrument,  (see Appendix C,
‘List of Related Instrument Handbooks’).  A summary of operation is given below:-

1. Use the mouse to point the cursor at the button on the selected instrument on the screen.
Click the left mouse button to operate the screen ‘button’ icon.

2. To Change Setpoint. Point and click on the  or  button

3. To View List
Headings

Point and click on the  button

Successive clicks will scroll through Instrument List
Headings

4. To View Parameters Having selected the desired list heading, point and click the

 button to select the desired parameter from the list

5. To Change a
Parameter Value

Point and click on the  or  button

6. To Select
Auto/Manual

Point and click the AUTO MAN  button

7. To Select Run/Hold Point and click the RUN HOLD  button
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3.5. INSTRUMENT PARAMETERS

Instrument parameters are settings in the instrument which you can change to suit the process.
In 2200 and 2400 instruments they are grouped under List Headings according to the
function they perform.  The List Headings are the names of sub-folders found in the Device
Browser.

3.5.1. To Display Instrument Parameters

Instrument parameters may be displayed in three ways:

1. Double click on the required instrument view (or the instrument name in the Device
Browser)

2. Right click on the instrument view (or the instrument name in the Device Browser) and
select Parameter List from the pop up window

3. Left click on the required instrument view.  From the Toolbar click Device Views �
followed by Parameter List

A list of parameters are displayed which are grouped under a List Heading.  This heading is
displayed in the upper left corner of the ‘parameters’ window, see Figure 3-3.

Figure 3-3:   Parameter List Heading

3.5.2. To Select a Different List of Parameters

1. In the Parameter List window, click on the folder .  This opens a small browser
window.

 The browser contains a number of folders, such as:
• Operator
• Programmer
• Access Edit Mode
• Config
• Register
• RIP

 Each of these folders contain sub-folders.  The lists of parameters are found in each of
these sub-folders.  A full list of parameters is given in the relevant instrument handbook.
See Appendix C ‘List of Related Instrument Handbooks’..

2. Open the required folder by double clicking on the folder (or folder name), or click

against the folder.
3. Open the required sub-folder by double clicking on the folder (or folder name), or click

OK.

The names and number of folders is dependant on
the particular instrument type.  This list applies to
2400 series
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3.5.3. To Display the Device Browser
From the View menu select Device Browser, (see also ‘To Customise the Display’ paragraph
3-6).  This will split the lower part of the iTools display into two sections - see Figure 3-4.
1. The right hand section will show the selected parameter list, as selected above.
2. The left hand section will show the Device Browser.  This will open on the folder

containing the selected Parameter List Heading.

3.5.4. To Select a Different List of Parameters using the Device
Browser

1. Single click on a folder or name of the list heading.  This has the same effect as the small
browser window in 3.5.2 above.

2. Double clicking the folder, or pressing , will open a list of parameter tags.  These tags
may be used to copy parameters when they are ‘wired’ between I/O modules and function
blocks in controllers such as 2500 and 2600.  See Chapter 7 - User Wiring.

Figure 3-4:   Parameter Lists

Device Browser showing
the name of the

Parameter List Heading

Read only parameters are shown in blue
Read/Write parameters are shown in black

Click on a folder to choose
a new set of parameters

Parameter List associated
with the chosen list heading

Selected instrument
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3.5.5. To Change Parameter Values
Parameters can be Read only or Read/Write.  Read only parameters are shown in blue and
read/write parameters are shown in black in the parameter lists.  Only Read/Write parameter
values can be changed.  Parameter visibility also depends upon the access level of the
instrument (to change Access Level see Paragraph 4.1.2).and some parameters can only be
changed within their set limits, eg SP (setpoint) whichhas high and low limits attached.

Parameter values can be Analogue Values or Enumerated Values.  With analogue values
the integer value can be adjusted between maximum and minimum limits.  With enumerated
values a selection of states can be made.
There are three ways to change parameter values:-

1. From the Parameter List window double click on the selected parameter
2. From the Parameter List window right click on the selected parameter and from the pop

up menu select Edit Parameter Value
3. From the menu bar select Parameter List and from the pop up menu select Edit

Parameter Value

A pop up window will appear, see Figure 3-5.

4. If the parameter is an analogue value, type in the
new value and Click OK or Apply

Care should be taken to ensure that parameters are not
set to values which may interfere with the expected
operation of the process.  See notes at the end of
section 5.9.

5. If the parameter is an enumerated value, such as
‘Auto/Manual’, select the condition from the pull-
down list..  Enumerated values can have more than
two selections.

Note:       OK  will cancel the dialog box
Apply  will retain the dialog box

 

Figure 3-5:   Changing Parameter Values

Note:  The parameter lists make available all parameters (including those hidden in the
faceplate view) which can be accessed over comms.  This is a much longer list than is
available by operating the instrument via the face-plate menu system.  The complete list of
available parameters and their MODBUS addresses are given in the Series 2000
Communications Handbook, part no.  HA 026230.  These additional parameters may be
required if the instrument is integrated into a larger system,  See ‘User Wiring’  Chapter 7

You are now able to operate any Eurotherm 2000 series communicating instrument from the
screen.
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3.5.6. To Edit Parameters
In addition to changing values of parameters, the properties of parameters can be changed.
There are three ways to do this:-

1. From the Parameter List window right click on the parameter
 A pop up menu will appear.  This gives the following choices:-
a) Edit Parameter Value - allows parameter values to be changed - see section 3.5.5.
b) Edit Parameter Comment - allows a comment to be added against the parameter
c) Parameter Properties - allows the properties of the parameter to be viewed
d) Copy - allows the parameter to be copied to the clipboard for use in User Wiring

(see Chapter 7) or Watch/Recipe windows (see paragraph 3.8).
e) Refresh - allows the parameter list to be updated
f) Columns - allows columns to be added to or deleted from the parameter list

display, as follows:-
I. Description - the full name of the parameter
II. Address - the MODBUS address number
III. Limits - the high and low limits which are applied to the parameter
IV. Wireable - the device that the parameter is wired to.  This is not applicable to

2200 and 2400 series instruments.  See Chapter 7 for more information.
V. Comment - allows a comment to be displayed against each parameter

2. From the Menu Bar, left click on the Parameter List menu
 A pop up window will appear.  This gives the following choices:-
a) Edit Parameter Value - allows parameter values to be changed - see section 3.5.5.
b) Edit Parameter Comment - allows a comment to be added against the parameter
c) Parameter Properties - allows the properties of the parameter to be viewed
d) Browse - displays a small browse window
e) Refresh - allows the parameter list to be updated
f) Columns - allows columns to be added to or deleted from the parameter list

display, as follows:-
I. Description - the full name of the parameter
II. Address - the MODBUS address number
III. Limits - the high and low limits which are applied to the parameter
IV. Wireable - the device that the parameter is wired to.  This is not applicable to

2200 and 2400 series instruments.  See Chapter 7 for more information.
V. Comment - allows a comment to be displayed against each parameter

3. From the Device Browser, double click on the folder or parameter list name, OR

click  against the parameter list name.  This opens a list of parameter tags.
Right click on the parameter tag.  A small window gives the following choices:-

a) Edit  - allows parameter values to be changed - see section 3.5.5.
b) Properties - allows the properties of the parameter to be viewed
c) Copy - allows the parameter to be copied to a wireable parameter
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3.6. TO CUSTOMISE THE DISPLAY

The display can be customised as follows:

From the View menu:

9 Toolbar to select the toolbar
9 Status Bar to select the status bar
9 Panel Views to select instrument views
9 Device Browser to select device browser and parameter list headings

Figures 3-1 and 3-2 have been shown with the above views selected.  De-select any area of
the display by clicking the 9.  Change the size of an area by clicking the area boundary and
dragging the boundary to a new position, (see Figure 3-2).

Note: Throughout the remainder of this manual, unless otherwise stated, it will be assumed
that Toolbar, Status Bar and Panel Views are selected.

From the Options menu
9 Show Device Names To display the name of the clone file or device on

the instrument view
9 Show Labels on Toolbar To display the names against toolbar icons
9 Active Window Follows Device used when two or more clone files are open.

The active parameter list corresponds to the
instrument selected

Scaling Used when a mix of instrument sizes are displayed
on the same screen.  Instrument views may be
displayed to scale or changed in size relative to each
other

Update Rates By default :’Panel Views’ are updated every 1500ms
‘When No Key Pressed’ and every 100ms ‘When
Key Pressed’.
Parameter Lists are updated every 2000ms
It is recommended that these settings are only
changed in very special circumstances, for example
in networked systems

Decimal Places Value will be rounded to the number of decimal
places

Send Command To Server To send a command to a server in networked
systems

Clear Most Recently Used Lists Clear the most recently used files from the File and
Device menus

Save Settings Now Save the customised screen settings when selected
Save Settings on Exit Save the customised screen settings when iTools is

closed
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3.7. TO DISPLAY PARAMETERS OF TWO OR MORE
INSTRUMENTS

1. Choose an instrument.  From the Toolbar click Device Views �� followed by Parameter
List.

2. Choose a second instrument.  From the Toolbar click Device Views �� followed by
Parameter List.

3. Repeat 2 and 3 for further instrument parameter lists
4. Select Window to format the display.  The choices are:-

a) Tile Horizontally b) Arranges Parameter Lists horizontally

a) Tile Vertically b) Arranges Parameter Lists vertically

a) Cascade b) Arranges Parameter Lists in cascade

Note:  The display below is with the:
Device Browser de-selected and Window - Tile Vertically.

Figure 3-6:   Customising the Display

Toolbar

Panel
Views

Status Bar

Menu Bar
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3.8. STORING PARAMETERS IN RECIPE

A particular process may be required to run a range of products which require different
settings to be entered into the control system.  If these are held in a series of recipes a rapid
and accurate way of setting up the process can be achieved.
A recipe, therefore, is a customised set of parameters which can be given different values
which are stored in data sets.  It can be named - say, with the reference of the batch to which
it applies, and downloaded into the control system.
This section describes how to configure, store, and download recipes into the controllers.

3.8.1. To Open the Watch/Recipe Window

1. From the View menu select Watch/Recipe
2. A Watch/Recipe window is displayed, see Figure 3-7

Figure 3-7:   The Watch/Recipe Window

3.8.2. To Build a Recipe

Parameters of your choice may be placed into the recipe window in four ways, as follows:

1. From the Device Browser, locate the required parameter from the file structure as
described in section 3.5.4

a) Drag and drop the parameter into the Recipe window
b) Repeat the above for all required parameters

2. From the menu bar of the ‘Watch/Recipe’ window click  ‘Browser for parameter
to add to recipe’.

a) From the small browser window select the parameter and either double click the
parameter or click OK

3. From the main menu bar click ‘Watch/Recipe’

a) Click   ‘Add Parameter’
b) From the small browser window select the parameter and either double click the

parameter or click OK

4. Right click in the Watch/Recipe window and click    ‘Add Parameter’
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3.8.3. To Remove a Parameter From the List

1. Click to highlight the parameter which is no longer required in recipe

2. From the menu bar of the ‘Watch/Recipe’ window, click  ‘Remove the selected
parameter from this recipe’

OR
Press Ctrl+Del

OR

Right click on the selected parameter and click  ‘Delete Parameter’

3.8.4. To Save The Current Recipe

1. From the menu bar of the ‘Watch/Recipe’ window, click  ‘Save’
2. For a new recipe the Save As dialog box will appear.  Save the recipe in the appropriate

directory with an appropriate file name

3.8.5. To Open A New Recipe

1. From the menu bar of the ‘Watch/Recipe’ window, click  ‘Create a new
watch/recipe list

Parameters may be added to and removed from this list as described in 3.8.2 and 3.8.3, and
the new recipe saved as described in 3.8.4

3.8.6. To Open An Existing Recipe

1. From the menu bar of the ‘Watch/Recipe’ window, click  ‘Open an existing
watch/recipe file’

2. From the file control menu select the required file and click OK or double click on the
file name

3.8.7. To Enter A Parameter Value

1. In the Watch/Recipe window, either double click on the parameter
 OR
2. Right click on the parameter and select ‘Edit Parameter Value’
3. From the dialog box type in the new value or if the parameter is enumerated select the

new state from the list

Note:-  If the message ‘Value rejected by device’ appears, check that the parameter is
read/write.  These are shown in black in the parameter lists.  Parameters shown in blue are
read only.  Some parameters can only be written to under certain conditions, for example,
when the instrument is in configuration mode.
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3.9. DATA SETS

Data sets allow you to choose different sets of parameter values, in a given recipe, depending
upon the conditions required to run the process, eg, the type of batch to be run.
Up to 32 data sets can be added.  Data sets can be deleted, copied and pasted from one to
another or captured from the current running conditions in the instrument.  These are
described in the following sections.

3.9.1. To Add A Data Set

1. From the Watch/Recipe window click  ‘Create a new empty data set’
OR

2. Right click in the area of the data set and click  ‘New Data Set’
 

3.9.2. To Delete A Data Set

1. Select the data set to be deleted and, from the Watch/Recipe window, click  ‘Delete
the selected data set’

OR

2. Right click on the data set to be deleted and click  ‘Delete Data Set’

3.9.3. To Copy And Paste Data Sets

This is useful if only a few parameters are changed from one data set to another.
1. Right click in the data set to be copied
2. From the pop up window click Copy Data Set
3. Right click in the data set to be copied to
4. From the pop up window click Paste Data Set
A parameter can be edited by double clicking on the parameter and from the pop up window
enter the new value.

3.9.4. To Rename A Data Set

A new data set is given a default name, eg Data Set 1.  A title of your choice can be given as
follows:-
1. Right click the data set
2. From the pop up window enter the required title using alpha-numeric characters.
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3.9.5. To Enter The Current Values From The Controller

It is often convenient to ‘snapshot’ the current values of parameters in a controller into the
current recipe.  This is useful, for example, when the process is running at its optimum
settings for the batch or job being processed.
This may be done in two ways

1. From the menu bar of the ‘Watch/Recipe’ window, click  ‘Capture current
values into a data set’

 OR

2. Right click in the section containing ‘Data Set’ and click  ‘Snapshot Values’
 
3. If more than one data set is displayed, right click in the data set in which you wish the

current values to be stored, and repeat 2 above
4. If no data set is displayed or a new data set is required, right click in the area containing

the data set and click  ‘New Data Set’.  OR from the Watch/Recipe menu bar click

 ‘Create a new empty data set’

3.9.6. To Download A Recipe Into An Instrument

The parameter values stored in the data set of a recipe can be downloaded into an instrument
in two ways:-

1. Click in the column containing the data set to be downloaded then click  ‘Download
the selected data set to the device’

 OR

2. Right click in the column containing the data set to be downloaded, then click 
‘Download Values’

Figure 3-8 shows an example of a recipe with data sets which may be configured using the
above procedures.

Figure 3-8:    Example of a Recipe
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4.  Chapter 4   QUICK TOUR 2

4.1. INSTRUMENT CONFIGURATION AND CLONING

This quick tour is a step by step guide to configuring and setting up parameter values in
Eurotherm 2000 series instruments.  iTools allows instrument configuration details and
commissioning values to be saved to a file which can be copied (cloned) to other instruments
of the same type.

Note:  This chapter shows 2200 and 2400 series instruments only, but the principles apply
equally for other 2000 series instruments such as 2500DIN Rail Controller.

Note:  This quick tour assumes that you have completed Quick Tour 1, or that you have had
experience with iTools and the operation of 2200 and 2400 series instrument.

About this Quick Tour

◊ To configure an instrument

◊ To set access level

◊ To configure an alarm type

◊ To set alarm trip levels

◊ Cloning

◊ To create a clone file from a connected instrument

◊ To clone from a file

◊ To edit a clone file

◊ To clone from a simulated instrument
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4.1.1. To Configure an Instrument
The most direct way to operate or configure an instrument using iTools is through the
instrument view.

Click on the instrument you wish to configure and operate it in exactly the same way as the
actual instrument.  This is described in detail in the relevant instrument ‘Installation and
Operation Handbook’, a full list of which is given in Appendix C .

The instrument can also be operated or configured using the Device Browser and Parameter
Lists in iTools.  The following example is included as an introduction to these features.

4.1.2. To Set Access Level
The instrument must be set to configuration level.  This may be done from the instrument or
through iTools.  Through iTools it is not necessary to enter a security code, and there are two
ways to enter configuration level:-

1. Right click on the Instrument View  (or the device name in the Device Browser).  From
the pop up menu select Set Access Level � Configuration

OR
2. From the menu bar, click Device � Set Access Level � Configuration

When the instrument is in configuration level a warning  is displayed, in iTools, on the
instrument view.

WARNING!  When the instrument is in configuration mode it will not be controlling the
process.

4.1.3. Example:  To Configure An Alarm Type from Parameter
Lists

1. Double click on the Instrument View to open the parameter list, or from the toolbar click
Device Views �� followed by Parameter List.  The display will be as shown in Figure 3-
4, depending on items ticked in the View menu

2. Select ‘Click here to choose a list’ (or choose the required list if already open)

Figure 4-1:   Selecting a Parameter List
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3. From the small browser
window box double
click on Config

Figure 4-2:   Small Browser Window

4. From the Config list select and double click AL  (the Alarm configuration list)

This list shows an example of the current
configuration for each of up to the four
alarms available in a 2400 instrument.
The relevant Installation and Operation
Handbook gives a full description of the
alarm types available.

If the instrument access level is
Operator, this list is read only.

To configure the parameter type, the
instrument must be in configuration
level - see Paragraph 4.1.2.

Figure 4-3:   Selecting a Parameter

5. To configure (or re-configure) the alarm type - double click the parameter name

From the dialog box select a new alarm type from
the list given in the table.

A complete list and description of the parameter
types available, together with their mnemonics is
given in the relevant ‘Installation and Operation
Handbook’ for the instrument in use - see
Appendix C.

Figure 4-4:   Configuring a Parameter Type

The selected conditions given in the above example, shows Alarm 1 (AL 1) set to a
Deviation, DEV, alarm.  The number in brackets is the enumeration value for the parameter.

6. Set up alarm latching or alarm blocking using the same procedure as described above.
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4.1.4. Example:  To Set the Alarm Trip Level
To set this parameter it is not necessary for the instrument to be in configuration level.

1. From the Device Browser click on the AL  List Heading in the Operator folder.  (See
Figure 4.5).  The alarm parameter list will be displayed in the right hand window

Figure 4-5:   Alarm Parameters

1. Double click on the selected parameter from the Parameter List
 OR
 From the menu bar click Parameter List select Edit Parameter Value
2. From the pop-up window,

type in the New Value
3. Click OK  or Apply

Figure 4-6:   Changing Alarm Value
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4.2. CLONING

The cloning feature allows the configuration and parameter settings of one instrument to be
copied into another.  This allows new instruments to be rapidly set up using a known
reference source or standard instrument.  Every parameter and parameter value is downloaded
to the new instrument which means that if the new instrument is used as a replacement it will
contain exactly the same information as the original.  Cloning is generally only possible if the
following applies:

• The target instrument has the same hardware configuration as the source instrument

• The target instrument firmware (ie. Software built into the instrument) is the same or a
later version than that of the source instrument.  The instrument firmware version is
displayed on the instrument when power is applied.

• Generally, cloning will copy all operational, engineering and configuration parameters
that are writable.  The communications address is not copied.

WARNING !
Every effort has been made to ensure that the information contained within the clone
files is a replica of that configured in the instrument.  It is the users responsibility to
ensure that the information cloned from one instrument to another is correct for the
process to be controlled, and that all parameters are correctly replicated into the target
instrument.
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4.2.1. To Create a Clone File From a Connected Instrument

To copy configuration and parameter details from one instrument to another follow the
procedure below.  Figure 4-7 shows an example of what you should see.

1. Connect the source instrument, and the instrument(s) to be cloned, to the iTools network,
as shown in Figure 2-2

2. Press the scanning button and wait for the instruments to appear in iTools
3. Select the source instrument by clicking on the panel view of the instrument or the

instrument name in the Device Browser
4. If you wish to change any parameters at this stage you may do so as described in Chapter

3
5. From the File menu, select Save to File
6. When the dialog box appears, enter a name for the file
7. Select the instrument to be cloned to by clicking on the panel view of the instrument or

the instrument name in the Device Browser
8. From the File menu, select Load Values From File
9. Press Open to download

Figure 4-7:   Instrument Cloning

Note:  A dialog box will appear which displays the progress of the cloning process.  If
cloning is not 100% successful error messages will be displayed which indicate areas where
the cloned instrument may differ from the source instrument.
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4.2.2. To Clone an Instrument from a File

It is not necessary to have the source instrument connected to the iTools network during
cloning.  The configuration details of the source instrument will normally have been
previously copied to a file by following steps 1 to 6 of the above procedure.

1. If you wish to examine or edit the parameter details press Open Clone from the Toolbar
or, from the File menu, select Open Clone File.

2. Open a clone file by double clicking on a clone file name or by selecting the clone file
and clicking Open.

3. The clone instrument details will be downloaded and displayed in the Panel Views
section.  The instrument parameter values are displayed in white to indicate that this is
not a physically connected instrument.  Parameter lists can be viewed in the same way as
an actual instrument - see Chapter 3

4. If you wish to load the clone file directly, either
 From the File menu select Send to Device ��…..select the instrument to be cloned   or
 Point and click on the instrument to be cloned and from the File menu select Load

Values From File.
5. When the file browser window appears select the required clone file and press Open to

download

Note:-  When cloning from an instrument or from a file the instrument is automatically
put into configuration level.
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4.2.3. To Edit a Clone File
1. From the toolbar select Open Clone or from the File menu select Open Clone File.
2. Open a clone file by double clicking on a clone file name or by selecting the clone file

and clicking Open.
 The clone instrument view will be displayed with parameter values in white to indicate

that it is not a physically connected instrument.  Figure 4-8 shows an example of what
you should see

3. Double click the instrument view to display the parameter lists
4. The value or configuration of any parameter can be changed as described earlier
5. From the File menu select Save or from the toolbar select Save
Note:  Save As may also be used to save a clone file to a different drive or file name using
usual Windows commands.

Figure 4-8:   Editing a Clone File

Clone file
parameters

View of a
clone file
instrument
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4.2.4. To Clone From a Simulated Instrument

In certain cases a physical instrument may not be available to copy from.  Supplied with
iTools are ‘New Clone Files’ which allow you to select a pre-determined template for a
particular instrument.  These files have the extension uit (Eurotherm Instrument Template)
and may be used for developing clone files.

1. Click New Clone from the toolbar or, from the File menu, select New Clone File
2. From the dialog box (Figure 4-9) select the instrument type from the list of clone files

available

Figure 4-9:   New Clone File Dialog Box

3. The instrument view appears on the screen - Figure 4-10 - (display colour white) which
can be configured, saved and loaded to a real instrument as described earlier.

Figure 4-10:   Simulated Instrument Produced From New Clone File
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 2500 DIN Rail Controller

5. Chapter 5   INTRODUCTION
This Chapter gives a brief introduction to the 2500 DIN Rail Controller and its operation in
iTools.  In principle running the 2500 in iTools is the same as that already described for the
2200/2400 series.  The explanations given in this chapter, therefore, are a summary of
previous chapters.

Additional features are available in iTools to enable the 2500 to configured to meet the
specific requirements of the process.  These features are described in subsequent chapters

About This Chapter

◊ What is the 2500 DIN rail controller

◊ To connect the 2500 DIN rail controller to a PC

◊ To set the address switch

◊ Baud rate

◊ Starting and exiting iTools

◊ Auto-detection

◊ To open panel views of instruments

◊ Instrument parameters

◊ To change parameter values

◊ To edit parameters

◊ Storing parameters in recipe
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5.1. WHAT IS THE 2500 DIN RAIL CONTROLLER

The 2500 DIN Rail Controller is a modular I/O system with local PID control blocks and
“User Wiring” allowing local computation and combinational logic.  The interface to it is
Modbus RTU or Profibus DP.

The 2500 is configured using iTools running on a personal computer under Windows 95 or
NT®.

The 2500s are designed to work as flexible controllers in a number of possible architectures:
• with The Eurotherm T2900 programmer/display
• with PC3000 as remote I/O
• with third party datapanels, PLC’s or with SCADA packages.

The unit is normally supplied as a number of separate parts, generally classified as follows:
the Base - “2500B”
the I/O Controller Module - “2500C”
the I/O Modules - “2500M”
the Terminal Units - “2500T”
the 24V Power Supply - “2500P.”

Figure 5-1:   General View of the 2500 DIN rail Controller

2500M Plug-
in I/O
Modules

DIN Rail

Optional
Fuses or
Isolator links

2500T
Terminal
Units

2500C I/O Control Module

Supervisory
communications
port

Configuration
port

AI2 DO4 RLY4 RLY4

2500B Base
Unit



2500 DIN Rail Controller iTools

5-4 User Handbook.         Part No HA026179       Issue 2.0            Oct-99

5.2. TO CONNECT A SINGLE 2500 CONTROLLER TO A PC

Connection of a single 2500 to a PC can be made through the RS232 configuration port
located on the front of the 2500 IOC module.  The connection is made via a RJ11 socket and
it is recommended that a standard RJ11 to 9 pin cable assembly is used.  This is available
from Eurotherm, as shown in ‘The Ordering Code’,  Appendix E
This cable plugs directly into the IOC and the PC as shown below.
When the 2500 is powered up, with a PC connected to the configuration port, it will
automatically start in configuration mode.  To guarantee this, the PC must not be
communicating at the time of powering up the 2500.

* Using the Eurotherm cable with the appropriate power supply means that the 2500 system
can be cloned or configured by taking the IOC module to any convenient location remote
from the installation.

Figure 5-2:   Connection Between IOC And PC Using The Comms Port
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See also Ordering Code, Appendix E.
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5.3. TO CONNECT MORE THAN ONE 2500 TO A PC

Connection of multiple 2500 controllers to a PC can be made through the RS485 sockets
located on the front of the 2500 IOC Termination Unit.
It is recommended that the connections between 2500 and the PC, and connections between
multiple 2500 controllers, use standard RJ45 cable assemblies.

Two RJ45 sockets are fitted to the 2500 to provide a convenient way to connect multiple
instruments, as shown in Figure 5-3 below.  Also shown in Figure 5-3 are RJ45 line
terminators which provide a convenient way to terminate both ends of the communications
lines.

Both cables and terminators are available from Eurotherm see ‘The Ordering Code’,
Appendix E.

Figure 5-3:   Connection of Multiple 2500 Controllers

Note:-  The RS485 connection in the 2500 IOC module is internally connected to ground via
a high value resistor to prevent build up of static which in some installations could cause
damage to PC or controller.  It is recommended, therefore, that the 24V supply to the 2500
IOC module is not grounded.

Each base must be
set to a unique

address

RJ45 Cable Assemblies, Eurotherm Type No.
2500A/CABLE/MODBUS/RJ45/RJ45/0M5 (or
3M0)

PC

RJ45 Comms
Line

Terminator

RJ45 Comms
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5.4. TO SET THE ADDRESS SWITCH

The unit address and parity is selected by the dual in line (DIL) switch mounted on the IOC
terminal unit.
The unit address can be set between 1 and 64 using switch positions 1 to 6 in binary.
Parity has three possible states - none/even/odd, using positions 7 & 8.

Address switch set to zero is a special case in which the address is ‘soft’ configured, i.e.
configured and stored in non-volatile memory.

For addresses between 65 and 255 the address switch must be set all OFF and the address set
in software as follows:-
1. Connect the PC to the configuration port as shown in Figure 5-2 or 5-3
2. Set the address switch to all OFF.
3. Scan for a connected instrument.  See paragraph 5.7 ‘Autodetection’.
4. The instrument will appear at unit address 255.
5. Edit the address parameter to the new unit address required.  See section 5.9 ‘Instrument

Parameters’.

Note:  The switch is only read on power up.  This means that if its setting is changed whilst
the unit is running it will have no effect, until the unit is powered down and turned back
on again.

Figure 5-4:   The Modbus Address Switch Set To -Unit Address 05, Parity off

Figure 5-5:   The Profibus Address switch

5.5. BAUD RATE

During autodetection, iTools will automatically scan for instruments connected to the PC
comms ports.  It will assume the baud rate of the first instrument detected - i.e. the one with
the lowest address.  Any subsequent instrument which has been set to a different baud rate
will show in iTools as a ‘Comms Error’.
This means that all units on a common line must have the same baud rate and parity, as well
as a unique address.  See 5.9.6  ‘To Set Baud Rate’

ON

OFF

1234567

1248163264

Switch position

Profibus Address

ON

OFF

12345678

12481632OP

EP

Switch position

Modbus Address

P Parity on

P Parity off

O Odd

E Even
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5.6. STARTING AND EXITING ITOOLS

5.6.1. To start iTools
iTools may be started in either of the following ways:
 
I. Directly

A. From the Windows Start Bar, click Programs.
B. Select Eurotherm iTools
C. Click iTools

 
II. Indirectly

A. Open an instrument clone file, recognisable by its .uic file extension,
directly from Windows Explorer.

5.6.2. To exit iTools

1. Click Exit  from the iTools File menu,
 

5.7. AUTODETECTION

1. Press the button.                                This will change to Scanning

iTools will search for up to 32 Eurotherm instruments connected to the network.  It will
check instrument addresses and baud rates.  When all connected instruments have been found
panel views are automatically displayed in the iTools window (assuming Panel Views has
been checked in the View menu)..  Stop iTools scanning by pressing the Scanning button
once all bases have been identified.

5.8. TO OPEN PANEL VIEWS OF INSTRUMENTS

Since the 2500 DIN rail controller consists of a set of ‘blind’ modules it does not have a
faceplate in the same way as a discrete instrument.  Panel views of the product are, however,
available as a fixed image.  The 2500 DIN rail controller, therefore, is configured and
operated using the parameter lists.  A panel view may be opened in any of the following
ways:

1. By enabling background scanning for new devices.  This can be from the iTools main
menu or toolbar

2. By selecting the Add Devices command from the iTools menu or toolbar.  This will
display a list of available devices (both real and simulated) to select from

3. By running a customised application file using usual Windows commands.  These have
the extension .uic
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5.9. INSTRUMENT PARAMETERS

Instrument parameters are settings in the instrument which you can change to suit the process.
In 2500 DIN rail controllers they are grouped under List Headings according to the function
they perform.  The sub-folders, found in the Device Browser, assume the names of the List
Headings.
The groupings are not necessarily the same as 2200 and 2400 series instruments.

5.9.1. To Display Instrument Parameters

Instrument parameters may be displayed in three ways:

1. Double click on the required instrument view (or the instrument name in the Device
Browser)

2. Right click on the instrument view (or the instrument name in the Device Browser) and
select Parameter List from the pop up window

3. Left click on the required instrument view.  From the Toolbar click Device Views �
followed by Parameter List

A list of parameters are displayed which are grouped under a List Heading.  This heading is
displayed in the upper left corner of the ‘parameters’ window, see Figure 4-5.

Figure 5-6:   Parameter List Heading

5.9.2. To Select a Different List of Parameters

1. In the Parameter List window, click on the folder .  This opens a small browser
window.

 The browser contains a number of folders, such as:
• Operator
• User Alarms
• Control
• I/O
• User Wiring

 Each of these folders contain sub-folders.  The lists of parameters are found in each of
these sub-folders.  A full list of the folders and parameters is given in Chapter 8.

2. Open the required folder by double clicking on the folder (or folder name), or click

against the folder.
3. Open the required sub-folder by double clicking on the folder (or folder name), or click

OK.
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5.9.3. To Display the Device Browser
From the View menu select Device Browser, (see also ‘To Customise the Display’ section 3-
6).  This will split the lower part of the iTools display into two sections:-
1. The right hand section will show the selected parameter list, as selected above.
2. The left hand section will show the Device Browser.  This will open on the folder

containing the selected Parameter List Heading.

5.9.4. To Select a Different List of Parameters using the Device
Browser

1. Single click on a folder or name of the list heading.  This has the same effect as the small
browser window in 5.9.3 above.

2. Double clicking the folder, or pressing , will open a list of parameter tags.  These tags
may be used to copy parameters when they are ‘wired’ between I/O modules and function
blocks in controllers such as 2500 and 2600.  See Chapter 7 - User Wiring).

5.9.5. To Change Parameter Values
Parameters can be Read only or Read/Write.  Read only parameters are shown in blue and
read/write parameters are shown in black in the parameter lists.  Only Read/Write parameter
values can be changed, and some parameters, such as configuration parameters, can only be
changed if the access level is correct.  To change Access Level see Paragraph 4.1.2

Parameter values can be Analogue Values or Enumerated Values.  With analogue values
the integer value can be adjusted between maximum and minimum limits.  With enumerated
values a selection of states can be made.
There are three ways to change parameter values:-

1. From the Parameter List window double click on the selected parameter
2. From the Parameter List window right click on the selected parameter and from the pop

up menu select Edit Parameter Value
3. From the menu bar select Parameter List and from the pop up menu select Edit

Parameter Value

A pop up window will appear, as shown in Figure
5-7a or b.

4. If the parameter is an analogue value, type in the
new value and Click OK  or Apply

Figure 5-7a:   Changing Parameter Values
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5. If the parameter is an enumerated value, such as
‘Auto/Manual’, select the condition from the pull-
down list..  Some enumerated values can be
selected from two or more alternatives.

Note:       OK  will cancel the dialog box
Apply  will retain the dialog box

 

Figure 5-7b:   Changing Parameter Values

Note:  The parameter lists make available all parameters which can be accessed over comms.
The complete list of available parameters and their MODBUS addresses are given in Chapter
8

5.9.6. Example:  To Set Baud Rate
1. From the Device Browser, click Operator → COMMS → Baud
2. Double click this parameter
3. From the pop up window click �
4. Select the required baud rate, and click OK or Apply.
Baud rates of 9600 and 19,200 are supported on version 1.04 of 2500

You are now able to operate the Eurotherm 2500 DIN rail controller using iTools.

Notes:-
1. Care should be taken to ensure that parameter values are not set to values which may

interfere with the expected operation of the process.
For example:
In a ramp to set point or programmer application, do not set the parameter ‘Hb’ - ‘SP Rate
Limit Holdback Value’ to zero when the parameter ‘Hbty’ - ‘SP Rate Limit Holdback Type’
is set to ‘band’ - Band Alarm’.
This will prevent the program from ramping.
The value of ‘Hb’ should be set to a value which does not prevent the programmer from
running even if ‘Hbty’ is set to ‘Hi’, ‘Lo’ or ‘band’.

In the 2500, these parameters are found under:
Control → LOOP01 (or 02) → L01_SP

2. If any alarm is set to type ‘Rate’ or ‘Deviation’ (high, low or band), then the alarm
setpoint must be set to a positive number.

3. Analogue Output module output limits must not be set outside the normal working range
of the output,  i.e. For 0 to 10V output set low limit to 0V and high limit to 10V.  For 0 to
20 mA output set low limit to 0mA and high limit to 20mA.
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5.9.7. To Edit Parameters
In addition to changing values of parameters, the properties of parameters can be changed.
There are three ways to do this:-

1. From the Parameter List window right click on the parameter
 A pop up menu will appear.  This gives the following choices:-
a) Edit Parameter Value - allows parameter values to be changed - see section 5.8.5.
b) Edit Parameter Comment - allows a comment to be added against the parameter
c) Parameter Properties - allows the properties of the parameter to be viewed
d) Copy - allows the parameter to be copied to the clipboard for use in User Wiring

(see Chapter 7) or Watch/Recipe windows (see section 5.10.)
e) Refresh - allows the parameter list to be updated
f) Columns - allows columns to be added to or deleted from the parameter list

display, as follows:-
I. Description - the full name of the parameter
II. Address - the MODBUS address number
III. Limits - the high and low limits which are applied to the parameter
IV. Wireable - the device that the parameter is wired to.  See Chapter 7 for more

information.
V. Comment - allows a comment to be displayed against each parameter

2. From the Menu Bar, left click on the Parameter List menu
 A pop up window will appear.  This gives the following choices:-
a) Edit Parameter Value - allows parameter values to be changed - see section 5.8.5.
b) Edit Parameter Comment - allows a comment to be added against the parameter
c) Parameter Properties - allows the properties of the parameter to be viewed
d) Browse - displays a small browse window
e) Refresh - allows the parameter list to be updated
f) Columns - allows columns to be added to or deleted from the parameter list

display, as follows:-
I. Description - the full name of the parameter
II. Address - the MODBUS address number
III. Limits - the high and low limits which are applied to the parameter
IV. Wireable - the device that the parameter is wired to.  See Chapter 7 for more

information.
V. Comment - allows a comment to be displayed against each parameter

3. From the Device Browser, double click on the folder or parameter list name, OR

click  against the parameter list name.  This opens a list of parameter tags.
Right click on the parameter tag.  A small window gives the following choices:-

a) Edit  - allows parameter values to be changed - see section 5.8.5.
b) Properties - allows the properties of the parameter to be viewed
c) Copy - allows the parameter to be copied to a wireable parameter
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5.10. STORING PARAMETERS IN RECIPE

A particular process may be required to run a range of products which require different
settings to be entered into the control system.  If these are held in a series of recipes a rapid
and accurate way of setting up the process can be achieved.
A recipe, therefore, is a customised set of parameters which can be given different values
which are stored in data sets.  It can be named - say, with the reference of the batch to which
it applies, and downloaded into the control system.
This section describes how to configure, store, and download recipes into the controllers.

5.10.1.    To Open the Watch/Recipe Window

1. From the View menu select Watch/Recipe
2. A Watch/Recipe window is displayed, see Figure 5-8

Figure 5-8:   The Watch/Recipe Window

5.10.2.    To Build a Recipe

Parameters of your choice may be placed into the recipe window in four ways, as follows:

1. From the Device Browser, locate the required parameter from the file structure as
described in section 5.9.4

a) Drag and drop the parameter into the Recipe window
b) Repeat the above for all required parameters

2. From the menu bar of the ‘Watch/Recipe’ window click  ‘Browser for parameter
to add to recipe’.

a) From the small browser window select the parameter and either double click the
parameter or click OK

3. From the main menu bar click ‘Watch/Recipe’

a) Click   ‘Add Parameter’
b) From the small browser window select the parameter and either double click the

parameter or click OK

4. Right click in the Watch/Recipe window and click    ‘Add Parameter’
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5.10.3.    To Remove a Parameter From the List

1. Click to highlight the parameter which is no longer required in recipe

2. From the menu bar of the ‘Watch/Recipe’ window, click  ‘Remove the selected
parameter from this recipe’

OR
Press Ctrl+Del

OR

Right click on the selected parameter and click  ‘Delete Parameter’

5.10.4.    To Save The Current Recipe

1. From the menu bar of the ‘Watch/Recipe’ window, click  ‘Save’
2. For a new recipe the Save As dialog box will appear.  Save the recipe in the appropriate

directory with an appropriate file name

5.10.5.    To Open A New Recipe

1. From the menu bar of the ‘Watch/Recipe’ window, click  ‘Create a new
watch/recipe list

Parameters may be added to and removed from this list as described in 5.10.2 and 5.10.3, and
the new recipe saved as described in 5.10.4

5.10.6.    To Open An Existing Recipe

1. From the menu bar of the ‘Watch/Recipe’ window, click  ‘Open an existing
watch/recipe file’

2. From the file control menu select the required file and click OK or double click on the
file name

5.10.7.    To Enter A Parameter Value

1. In the Watch/Recipe window, either double click on the parameter
 OR
2. Right click on the parameter and select ‘Edit Parameter Value’
3. From the dialog box type in the new value or if the parameter is enumerated select the

new state from the list

Note:-  If the message ‘Value rejected by device’ appears, check that the parameter is
read/write.  These are shown in black in the parameter lists.  Parameters shown in blue are
read only.  Some parameters can only be written to under certain conditions, for example,
when the instrument is in configuration mode.
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5.11. DATA SETS

Data sets allow you to choose different sets of parameter values, in a given recipe, depending
upon the conditions required to run the process, eg, the type of batch to be run.
Up to 32 data sets can be added.  Data sets can be deleted, copied and pasted from one to
another or captured from the current running conditions in the instrument.  These are
described in the following sections.

5.11.1.    To Add A Data Set

1. From the Watch/Recipe window click  ‘Create a new empty data set’
OR

2. Right click in the area of the data set and click  ‘New Data Set’
 

5.11.2.    To Delete A Data Set

1. Select the data set to be deleted and, from the Watch/Recipe window, click  ‘Delete
the selected data set’

OR

2. Right click on the data set to be deleted and click  ‘Delete Data Set’

5.11.3.    To Copy And Paste Data Sets

This is useful if only a few parameters are changed from one data set to another.
1. Right click in the data set to be copied
2. From the pop up window click Copy Data Set
3. Right click in the data set to be copied to
4. From the pop up window click Paste Data Set
A parameter can be edited by double clicking on the parameter and from the pop up window
enter the new value.

5.11.4.    To Rename A Data Set

A new data set is given a default name, eg Data Set 1.  A title of your choice can be given as
follows:-
1. Right click the data set
2. From the pop up window enter the required title using alpha-numeric characters.
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5.11.5.    To Enter The Current Values From The Controller

It is often convenient to ‘snapshot’ the current values of parameters in a controller into the
current recipe.  This is useful, for example, when the process is running at its optimum
settings for the batch or job being processed.
This may be done in two ways

1. From the menu bar of the ‘Watch/Recipe’ window, click  ‘Capture current
values into a data set’

 OR

2. Right click in the section containing ‘Data Set’ and click  ‘Snapshot Values’
 
3. If more than one data set is displayed, right click in the data set in which you wish the

current values to be stored, and repeat 2 above
4. If no data set is displayed or a new data set is required, right click in the area containing

the data set and click  ‘New Data Set’.  OR from the Watch/Recipe menu bar click

 ‘Create a new empty data set’

5.11.6.    To Download A Recipe Into An Instrument

The parameter values stored in the data set of a recipe can be downloaded into an instrument
in two ways:-

1. Click in the column containing the data set to be downloaded then click  ‘Download
the selected data set to the device’

 OR

2. Right click in the column containing the data set to be downloaded, then click 
‘Download Values’

Figure 5-9 shows an example of a recipe with data sets which may be configured using the
above procedures.

Figure 5-9:    Example of a Recipe
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6.  Chapter 6   QUICK TOUR 3

6.1. CONFIGURATION OF I/O MODULES

The I/O modules available with the 2500 DIN Rail Controller are:
1. The two channel analogue input module  2500M/AI2
2. The two channel analogue output module  2500M/AO2
3. Quad digital input module  2500M/DI4
4. Quad digital output module  2500M/DO4
5. Relay module  2500M/RLY4
This chapter describes how to configure these modules to suit the I/O plant devices such as
sensors, transducers and actuators.

About This Chapter

◊ To Set Access Level

◊ I/O Module Types

◊ Channel Types

◊ Parameter Availability Settings

◊ Failure To Write A Value

◊ To set up other I/O parameters
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6.2. TO SET ACCESS LEVEL

The instrument must be set to configuration level.  This may be done in two ways:-

1. Right click on the Instrument View  (or the device name in the Device Browser).  From
the pop up menu select Set Access Level � Configuration

 OR
2. From the menu bar, click Device � Set Access Level � Configuration

Note:  When the instrument is in configuration level a warning   is displayed on the
instrument view.  No security code is required in iTools to enter configuration level.

WARNING!  When the instrument is in configuration mode it will not be controlling the
process.

6.3. I/O MODULE TYPES

There are five types of I/O module available in the 2500 controller which need to be defined
before they are ‘soft wired’ in the application,  see ‘User Wiring’ Chapter7.  These modules
are:
1. The Two Channel Analogue Input Module 2500M/AI2
2. The Two Channel Analogue Output Module 2500M/AO2
3. The Relay Module 2500M/RLY4
4. The Quad Digital Input Module 2500M/DI4
5. The Quad Digital Output Module 2500M/DO4

Each module is identified by its location in the 2500 base (1 to 16).  The required module
type must firstly be defined to correspond with the actual module type fitted.  It is then
necessary to define the functionality of each channel.  The procedure which follows gives a
general description of this process.

6.3.1. To Define I/O Module Type

1. Select Set Access Level � Configuration   (as described above).

2. From the Device Browser open the I/O folder by clicking  , or by double clicking on
the I/O folder or folder name.

3. Select the module to be defined (e.g. Module1) by clicking  , or by double clicking on
the Module folder or folder name.

4. Select the module type, (e.g. MOD01) by single clicking on the folder or folder name
5. This will open the Parameter List in the right hand window
6. From the Parameter List select the Requested Module Type (e.g. ReqModID).  This may

be done in two ways:-
a) by double clicking the ReqModID line.  OR
b) right click on the ReqModID line and from the small pop up window select

Edit Parameter Value
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7. From the small pop up window which appears, press � to open a list of module types
available.

8. Scroll to the Channel Type required and click OK  or Apply
9. The line Actual Module Type (ActModID)  will change to the selected module type to

confirm that the command was successful.  See table 6-1 for full list of module types.

Figure 6-1:   Defining a Module Type

In this example Module1 (MOD01), is defined as an analogue input (AI2)

Note:  The number in brackets (64) is the Modbus Address of the parameter

Name Description Values Meaning R/W
Mod01 LH_MOD_1 List Header Read
ModSta ModStatus Module Status Read
ActID ActMod_1 None (0)

DI4 (1)
DO4_EP (16)

DO4_24 (17)
DO4_SP *(18)

RLY4 (32)

None fitted
Digital Input
Dig Output External
PSU
24V Switched Output
Dig Output Self
Powered
Relay Output

Read only parameter
which confirms that the
requested module is
the same as the
module fitted

Read

ReqID ReqMod_1 AI2 (64)
AO2 (80)

Analogue Input
Analogue Output

Write parameter
defining the module
type

Write

ModVer ModVers_1 Module firmware
version

Read

Table 6-1:   Full Range of Module Types
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6.4. CHANNEL TYPES

Each module contains a number of channels  (generally, two for analogue modules and four
for digital modules).  Each channel must be configured to a type which corresponds to the
module type.  A module type configured as an analogue input, for example will have input
(linearisation) types such as thermocouple, RTD, etc.
The selected input type is then linearised using the input Linearisation Type.  It is possible
to configure any linearisation type with any input type  This allows, for example, an input
type configured for mA to be linearised to a thermocouple curve.  Care should be taken,
however, to ensure that the correct linearisation is applied to the input type selected.  An
input type configured as RTD, for example, would (normally) be linearised for PT100 but it
is equally valid to use any other linearisation curve.

A module type configured as an analogue output requires the output type to be defined.  The
choices are voltage or mA current.

Table 6-2, overleaf, lists the Channel Type choices for the different module types.

The values shown in Table 6-2 are grouped with the I/O module for which they are relevant.
This presentation will be shown in iTools when the check box ‘Hide Parameters which are
Not Relevant’ is ticked in the Options menu � Parameter Availability Settings.
If this box is not ticked, then all possible parameters for all module types are shown in the
iTools ‘Parameters’ display.  Those parameters which are not relevant to the configured
module type, however, are shaded in grey and their values cannot be adjusted.  In addition
some parameters are made read only and are shaded in blue.  This option is made available to
speed up configuration for those users who are very familiar with the positions of these
parameters.  See also Appendix B ‘The Menu Bar’.
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6.4.1. To Define Channel Type
1. From the Device Browser open the I/O folder by clicking , or by double clicking on

the I/O folder or folder name.

2. Select the module to be defined (e.g. Module01) by clicking , or by double clicking
on the Module folder or folder name.

3. Select the module channel number, (e.g. MO1-C1) by single clicking on the folder or the
folder name

4. From the Parameter List select Channel Type.  This may be done in two ways:-
a) by double clicking the Channel Type line.  OR
b) right click on the Channel Type line and from the small pop up window select

Edit Parameter Value
5. From the small pop up window which appears, press � to open a list of channel types

available
6. Scroll to the Channel Type required.  And click OK  or Apply
7. A full list of Channel Types available is given in Table 6-2

Figure 6-2:   Defining Channel Type

In this example Module 1, Channel 1 (MO1_C1) is defined as
a Resistance Thermometer input RTD linearised to a PT100 curve.
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6.4.2. Channel Types For Each Module
Channel Type for module:- Analogue Input  AI2

TYPE Meaning
TC (1) Thermocouple input
Pyro (2) Pyrometer input
mV (3) milli-volt input
mA (4) milli-amp input
V (5) Volts input
HiZV (6) High impedance voltage input, eg Zirconia probe
Ohms (7) Resistance input
HiOhms (8) High resistance input
Pot (9) Potentiometer

Channel Type for module:- Analogue Output  AO2

Value Meaning
V (0) (30) Voltage
MA (0) (31) Current

Channel Type for module:- Digital Outputs  DO4-EP; DO4-24; DO4-SP

Value Meaning
ONOFFO (40) On Off output
TIMEPR (41) Time proportioning output
VLVRSE (42) Valve raise *

Channel Type for module:- Digital Input  DI4

Value Meaning
ONOFF (50) On Off digital input
DEBNCE (51) De-bounce (for relay inputs)
PULSE (52) Pulse input

Channel Type for module:- Relay Output  RLY4

Value Meaning
ONOFFO (40) On Off output
TIMEPR (41) Time proportioning output
VLVRSE (42) Valve raise *

* If channel 1 or channel 3 is configured as Valve Raise, then the next channel, i.e. Channel 2
or 4, will automatically be configured as Valve Lower.  It is not possible to configure even
numbered channels for Valve Raise.
The number in brackets is the enumeration for the parameter.  This is the value corresponding
to the selected choice

Table 6-2:   Full Range of Channel Types
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6.4.3. Input Linearisation
If the Module Type is Analogue Input, it is necessary to configure the appropriate
linearisation curve for the sensor in use.  After setting up the Channel Type double click the
Linearisation Type line and from the small window select the appropriate curve.
Note:-  You can configure any Linearisation Type for any Channel Type, this allows, for
example, mA inputs to be linearised to a thermocouple curve.  Care should be taken,
however, to ensure that the correct curve is chosen for the input type configured.  The table
below gives the choices available:-

Value Meaning
J T/C (0) J thermocouple
K T/C (1) K type thermocouple
L T/C (2) L thermocouple
R T/C (3) R thermocouple
B T/C (4) B thermocouple
N T/C (5) N thermocouple
T T/C (6) T thermocouple
S T/C (7) S thermocouple
PL2 (8) Platinel 2 thermocouple
CUSTOM (9) Custom download
PT100 (10) 100Ω Platinum resistance thermometer
LINEAR (11) Linear volts or current
SQ ROOT (14) Square root

Note:-  The number in brackets is the enumeration for the parameter

6.5. PARAMETER AVAILABILITY SETTINGS

The Channel Types shown in Table 6-2 are grouped with the Module Type for which they are
relevant.  It is possible to display all available parameters whether or not they are relevant to
the Module Type selected.  This is to allow for faster configuration than may be possible if
the lists are segregated.

6.5.1. To Select Parameter Availability
1. From the Menu Bar, click Options
2. From the menu list, click Parameter Availability Settings
3. To display those parameters which are not relevant to the Module Type, check the box

‘Hide Parameters which are Not Relevant’
4. Un-check this box to show all parameters which are not relevant to the Module Type

selected.  These parameters are presented with a greyed background and cannot be
changed

5. Check the box ‘Mark Parameters according to Relevance and Availability’ to display a
further filtered list of parameters.  Some additional parameters listed will be Read only.
Note:-  This check box has no effect for clone files.
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6.6. FAILURE TO WRITE A VALUE

The message ‘Value Rejected by Device’ will appear if:
a) The instrument is not in configuration level, when the parameter selected is a

configuration parameter
 OR
b) An incorrect condition is requested.  For example, if a module is configured as a Digital

Input a parameter associated with any other type (AO,AI or DO) will not be accepted

6.7. TO SET UP OTHER I/O PARAMETERS

The previous pages describe how to set up the module types, channel types and input
linearisations for analogue modules. Associated with each of these steps are a number of
other parameters which may need to be configured.  Generally these are the values associated
with the particular configuration.. The principle of setting of these parameters is illustrated by
the following example

6.7.1. Example
To configure Module02, Channel 1 analogue output to 4-20mA

1. From the Device Browser select IO → Module02 → MO2_C1.
2. From the parameter list

a) Double click VALH and enter the value which defines the % PID output
required to give maximum output eg 100%

b) Double click VALL and enter the value which defines the % PID output
required to give minimum output eg 0%

c) Double click IOH and enter the value to give maximum electrical output  eg
100 = 20mA.

d) Double click IOL and enter the value to give minimum electrical output  eg 20
= 4mA.

A PID output of 0 - 100% will give an electrical output of 4 - 20mA.

A full list of parameters is given in the parameter lists in Chapter 8.
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7.  Chapter 7   Quick Tour 4

7.1. USER WIRING

User Wiring in the 2500 controller allows applications to be created by internally soft wiring
digital and analogue parameters together, either directly or by using a selection of
mathematical or logical functions.
The different aspects of User Wiring are:
1. Functions
Functions allow mathematical or logical calculations to be performed on individual or a pair
parameters.  They are accessed through a set of tabbed pages in the User Wiring Editor as
follows:-
• User Values.  This allows real numbers to be assigned to any or all of eight place holders.

These values may be used as inputs to Analogue and Logic calculations.
• Analogue Calc.  Up to sixteen simple analogue calculations can be performed, with the

output of each being written to one of sixteen Calculated Values.  In many cases, a
Calculated Value will be assigned directly to a wireable parameter, but more complex
calculations can be performed by chaining, i.e. using Calculated Values as inputs to
further calculations.  An example of an analogue calculation is shown in Figure 7-1.

• Logic Calc.  Logic or digital calculations are handled in the same way as analogue.
Examples of Logic Calculations include AND, OR, XOR and LATCH. An example of an
analogue calculation is shown in Figure 7-1.

 
 
 
 
 
 
 
 

Figure 7-1:   Examples of Analogue and Digital Functions
2. Connections
Connections provide the facility to ‘soft’ wire parameters between ‘function blocks’ and I/O
modules.  Function blocks are embedded applications in the 2500 controller, examples of
which are PID control, humidity, etc,.  They are accessed through a tabbed page in the User
Wiring Editor  as follows:-

• Wireable Params.  Wireable Parameters provide the facility to connect parameters to
function blocks to produce the desired application.

Figure 7-2:   Example of Wiring Parameters to a Function Block
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Before attempting any wiring it is recommended that a block diagram of the process or
application is drawn.  Each block should be allocated a reference name together with other
relevant information.

An example of a block diagram is given in Figure 7-3.  The elements of this block diagram
are taken as examples and are used in this chapter to explain the different aspects of User
Wiring listed above.

About This Chapter

◊ Example block diagram of a process
◊ The wiring editor
◊ User values
◊ Analogue calculations
◊ Logic (digital) calculations
◊ Output behaviour in error situations
◊ Wireable parameters
◊ Wireable Parameter Tables

7.2. EXAMPLE PROCESS BLOCK DIAGRAM

Figure 7-3 represents an example block diagram of a process control system.  It will be used
in this chapter to explain the principles of User Wiring. It is not intended to represent any
particular process solution and is presented here for illustrative purposes only.

The block diagram comprises the following sections:
1. A control loop, (loop1), which will be configured as a heat only temperature controller.

The input to the control loop is derived from an Analogue Input module.  The output
drives a time proportioning Digital Output module.

2. A control loop, (loop2), which will be configured as a humidity controller.  The 2500
DIN rail controller contains a humidity function block which calculates Relative
Humidity from wet and dry PRT input sensors.

3. A logic output is derived by the use of Analogue and Logic Calculations. The functions
of each of these blocks is described in this chapter.
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Figure 7-3:   An Example of a Process Block Diagram

A description of the application for each of the above blocks is given in the following pages
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7.3. THE WIRING EDITOR

Analogue and digital User Wiring is viewed or edited using a single set of tabbed pages:  one
page for User Values, one for Analogue Calculations, one for Logic Calculations and one
for Wireable Parameters.  The Wiring Editor simplifies production of applications by
allowing wiring links to be made by dragging and dropping parameters.

7.3.1. To Open the Wiring Editor

The Wiring Editor can be opened in three ways:-

1. From the toolbar click   next to Device Views
 OR
2. From the View menu click User Wiring
 OR
3. Right click on the instrument panel view or the device name in the Device Browser
4. From the pop up menu select User Wiring

Figure 7-4:   The Wiring Editor
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7.4. USER VALUES

User Values are intended for use as constants or comms inputs to calculations.

An example of a User Value is given in the Example Process Block Diagram Figure 7-3.  It is
shown as UserVal1 and provides a setpoint input (heater temperature threshold) to a Digital
Output block

Select the User Values tab.  This page is shown while editing either Analogue or Logic
Wiring.  It allows a floating point numeric value or a boolean to be entered in each of eight
User Value slots.

Figure 7-5:   User Values Tab

7.4.1. To Set Up a User Value
User Values can be set in two ways:-

1. Double click on the UserVal- box or its Value
 OR
2. Select the line containing the value which you wish to change.  Then right click on this

line.  From the small pop up window select Edit Parameter Value

A small dialog window will appear.  Type in the new value.

7.4.2. To Enter Text into the Comment Field
Text may be added into the comment field in two ways:-

1. Double click in the field in which you wish to enter the comment
 OR
2. Select the line containing the comment which you wish to enter.. Then right click on this

line.  From the small pop up window select Edit Parameter Comment

A small dialog window will appear.  Type in the text.
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7.5. ANALOGUE CALCULATIONS

The Analog Calc page provides a convenient way to perform a mathematical calculation on
two input variables.  The input variables can be analogue or digital values.  The Analog Calc
page allows you to set up the following conditions:
1. To soft wire up to two inputs of an analogue calculation block to outputs of a previous

stage of a process
2. To range each input individually by applying a multiplying factor
3. To perform a mathematical calculation between the two inputs.  Table 7-1 provides a full

list of the calculations which can be made
4. To apply a maximum and minimum limit on the result of the calculation
5. To provide a fallback value if the result of the calculation is incorrect
6. An optional method of wiring the output of the analogue calculation to the next stage of

the process

With the User Wiring window maximised, a table allows up to sixteen calculations to be
performed.  Each row of the table is labelled RealCV1 to RealCV16.  According to
whichever row of the table is selected (selection of individual cells is not possible), the form
below the table allows the current calculation to be edited.

Selection of inputs is made by pressing the ellipsis button   adjacent to the field.  This
brings up a small window containing a parameter browser from which the required parameter
can be selected.  Alternatively, from the main browser drag and drop the required parameter

into the field adjacent to the ellipsis  button

Wiring to wireable parameters is optional, and is made by adding entries to a list box.  If a
wireable parameter is selected which is already wired to, a warning dialog box appears which
allows either override of the previous wire or cancel the operation.
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Figure 7-6:   Analogue Calculation Tab

Table 7-1:   Analogue Calculation Operators

Analogue Wiring Operators
Name Meaning

None No function
Add Add
Subtract Subtract
Multiply Multiply
Divide Divide  (Divide by zero gives invalid

status and high limit output)
Abs Diff Absolute difference
Max Output = larger of both inputs
Min Output = lesser of both inputs
Hot Swap Use secondary input if primary fails
Sample/hold For full description see pages 7-8/9
Power xy  Where x = input 1 and y = input 2
Square Root Acts on input 1 only  input 2 is ignored
Log Log10    Both act on input 1 only
Ln Logn     Both act on input 1 only
10^X Exponential   Both act on input 1 only
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7.5.1. Example:   To Produce an Analogue Calculation Block

An example of an analogue calculation is shown in the Example Process Block Diagram,
Figure 7-3, and will be used to illustrate the principle of configuring analogue calculations.
This example is a variant of a ‘highest wins’ circuit, which compares the two inputs and
chooses the largest of the two.  The first input (input 1) is an analogue value (0 - 100), and is
taken from the output of the relative humidity function block.  The second input (input 2) is a
boolean which is taken from the output of a digital function block  The boolean has a
multiplying factor (of 50) applied to match the scaling of input 1.

If the boolean is not true the output is taken from input 1.  If the boolean is true then the value
appearing at the output is taken from input 1 if it is greater than 50 and from input 2 if input 1
is less than 50.

This particular configuration might be used in an application where it is required to maintain
a minimum level of power to a heater element depending upon the condition of a digital
input.

Figure 7-7:  Analogue Calculation Block (‘Highest Wins’)

The wiring for this example is shown in Figure 7-6.

1. Select the Analog Calc tab
2. Select one of the sixteen analogue operations by clicking on the RealCV- line

3. Click the ellipsis button  against Input1  and from the small browser window locate
the parameter to be wired from.  In this example the parameter is the output from the
humidity block, LOOP02.wOP, and will be found through the path  ‘Control → Loop02
→ wOP.  Click OK, or double click on the name of the parameter (wOP)

4. In the Input1  multiplier box enter the multiplying factor on this input value (e.g. 1)

5. Click the ellipsis button  against Input2  and from  the small browser window locate
the parameter to be wired from.  In this example the parameter is the output from a digital
calculation block, BoolCV, and will be found through the path  ‘User Wiring →
Digital→ DOPR01 → BoolCV’.  Click OK, or double click on the name of the parameter

6. In the Input2  multiplier box enter the multiplying factor on this input value (e.g. 50)
7. Click the drop down menu,   ,in the Operator box and from the small window select

the mathematical function required.  In this example Max

Input 2

AOPR01

Max

Input 1From RelHumid output
(LOOP02.wOP)

From DIGOP1
(DOPR01.BoolCV)
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8. In the Hi and Lo Limit  boxes enter the maximum and minimum output range.  In this
case 100% and 0%

9. In the Fallback box enter a value to that you want the output to go to if the result of the
calculation falls outside the output limits, (see ‘Output Behaviour in Error Situations’
paragraph 7.5.2).

10. Check the Fallback Overrides Limits box if you want the output to take up the fallback
value in the event that the output limits are exceeded.  If this box is not checked the
output will clamp at the limit value.

11. To add a comment against each line select the line and type in the Comment box

Notes:
1. The precise behaviour of Fallback is described in the tables overleaf
2. The view taken in Figure 7-6 has the Panel View turned off
3. The current values of the Input parameters are displayed, in blue, on the Analogue

Calculation view.  They are found immediately above the ellipsis button, see Figure 7-6
4. The current value of the Output is displayed, in blue, on the Analogue Calculation view.

The result of the calculation can, therefore, be viewed directly, together with the values of
the inputs, see Figure 7-6


